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What is MergeFax?



MergeFax 2.0 is a powerful new program that allows you to mail-merge group fax hundreds of PERSONALIZED faxes with Word for Windows 6.0 and WinFax PRO 3.0, 4.0 (and WinFax PRO for Networks)—all with one simple keystroke.



You can now "touch" all of your customers at the stroke of a key, sending the latest pricing information, special offers, "Thank you" replies, and new product information. Or send customized graphs, charts, letters, and up-to-date sales information to all your sales agents in the field. Imagine this power in your company.



MergeFax is one of those rare programs that will save you and your employees hours of time. Plus, the date and time scheduling features alone will save you big bucks by allowing you to schedule your faxes late at night when the rates are dirt cheap.



Before the creation of MergeFax, the best you could do was "group fax" the same document to everyone. Ex: "Dear Customer, thank you for your interest in Ski Chalet products."



The power of MergeFax is that it allows you to use Word for Windows 6.0's awesome mail-merge features to group fax hundreds of faxes that are PERSONALIZED to each individual. Ex: "Dear Jim, thank you for your interest in our winter ski product line." "Dear Joe, thank you for your interest in our arrow ski downhill racers." Etc.



MergeFax-ing is as simple as these 2 steps:

1. Set up your mail-merge main document.

2. Hit Alt-M and START.



Here’s how it works:



MergeFax automatically merges each data record, scans the document to find the recipient’s name and fax number, and then (using DDE) passes this information over to WinFax PRO.



MergeFax queues up all the faxes in WinFax PRO's event list—either to be sent immediately or scheduled for a later date and time.



MergeFax automatically sets the fax driver and resets the printer driver for you—so you don’t have to fiddle with driver settings. You just hit Alt-M and Start, and MergeFax takes care of everything else.



MergeFax does all this in minutes! On a 486-66 machine, MergeFax queues up WinFax PRO's event list with 100 faxes in 5 minutes!





Installation and Setup



To setup MergeFax, DOUBLE CLICK the "install button." The MergeFax Setup dialog box will appear.



� MACROBUTTON MergeFaxInstall ��



Note: This setup is made to be run again and again, anytime you wish to choose different default settings or re-design your own custom identifiers.



Note: For MergeFax to install properly, all three files (MERGEFAX.DOC, MERGEFAX.DOT, and MERGEFAX.BMP) must be in the same directory (for example C:\MERGEFAX). This is because the install macro looks for MERGEFAX.DOT and MERGEFAX.BMP in the same directory that you open MERGEFAX.DOC.



We recommend you create a directory called C:\MERGEFAX to store all the MergeFax files. This way you can re-run the Install MergeFax macro any time in the future should you decide to change any of the defaults or re-design your own custom identifiers.



This is what the install program does:

It copies the MergeFax macro into your NORMAL.DOT template so that it will be available globally.

It assigns the keyboard shortcut key of Alt-M to the MergeFax macro.

It adds MergeFax to the menu of your choice.



Note: It adds these settings to your NORMAL.DOT template. So you won't see these changes until you open a file based on the NORMAL.DOT template. This User's Guide is attached to the MERGEFAX.DOT template.





Sample.doc



To see a demonstration of MergeFax 2.0 in action, we have included a sample mail-merge "main" document (SAMPLE.DOC) attached to a sample "data source" (SAMPDATA.TXT) that contains 5 records.



To run MergeFax, simply open SAMPLE.DOC and hit alt-m. Then schedule for some future time (or WinFax PRO will start sending the faxes immediately after MergeFax is complete and you'll have to cancel each one). To start MergeFax, hit the "start" button.



That's it! MergeFax will automatically switch to the fax driver, merge each data record, scan each merged document to find the recipient’s name and fax number, pass them over to WinFax PRO, queue up all the faxes in WinFax's event list with their pending date and times, and then reset your printer driver back to whichever default printer it was on.





MergeFax Identifiers: “To:” & “Fax:” or Whatever you want!



MergeFax searches for “To:” and “Fax:” (or any custom identifiers you create) to identify the recipient’s name and fax number.



MergeFax allows you to create any custom identifiers you wish! For example, if you prefer “Fax #:”, or “Fax No.:”, or “Fax Number:”, etc., simply re-run the setup program above to make the identifiers anything you want.



Because MergeFax scans the entire document, the “To:” and “Fax:” information can be anywhere in your fax. Normally, they will be on the fax cover page, or if you are faxing a one page letter, they will be on that. But the nice thing about MergeFax is that they don’t have to be. They can be anywhere. And in any order.



For example, they can be on the same line, like this:



				To: Woody Allen Fax: 555-555-5555



Or they can be reversed, like this:



				Fax: 555-555-5555 To: Woody Allen



Or they can be separated by tabs, like this:



				To: 				Woody Allen

				Fax:			555-555-5555



Or they can have leading text on the same line, like this:



				This message To: Woody Allen



Or they can have following text on the same line (as long as there is a tab or at least two spaces after the name or fax number), like this:



				To: Woody Allen  Date: June 20, 1995



In fact, MergeFax's search routines are so smart, it will even work with everything crammed together on one line, like this:



				To:Woody AllenFax:555-555-5555



Note: MergeFax always goes to the top of the document and searches down. So, if there is more than one identical identifier in a document, it will always find the first one.





The Big Tip: "Hidden Identifiers"



MergeFax's ability to find "hidden identifiers" gives you complete flexibility in designing your faxes to look exactly the way you want, while at the same time allowing MergeFax to find the recipient's name and fax number accurately. To understand how this works, please see the following 3 examples:



Example 1: Hiding the "To:" and/or "Fax:"



If you don't want the “To:” or “Fax:” to show up on your fax, you can make them “hidden identifiers” by selecting them and choosing Format>Font>Hidden text. MergeFax will still find the name and fax number, but the hidden “To:” or “Fax:” won’t show up on your fax.



For example, you might want to fax a one page letter containing the recipient’s name, address, and fax number—but in this case, you wouldn’t want the word “To:” to show up. Simply do it like this:



To: Jay Bonzi

396 17th St.

Paso Robles, CA  93446

Fax: 805-238-5798



Dear Jay,



I love MergeFax! Great work! Kudos!



(Note: there is a hidden “To:” before the name Jay Bonzi. If you cannot see this, hit Tools>Options>View>Nonprinting Characters>Hidden Text. Once you see it, and know it’s there, go ahead and hit File>Print Preview to see that it doesn’t show up when you print and/or fax.)



Example 2: Using Separate Cells



If you split “To:” and "Woody Allen" into separate cells, MergeFax has no way of knowing they are related.



To:�Woody Allen��

But not to worry! If you prefer this two-cell method, you can easily make it work with hidden identifiers! Simply custom design a name identifier (into anything different than "To:". For example, I use "To>"). Then simply add that "To>" as a hidden identifier. Like this:



To:�To> Woody Allen��

MergeFax will search for "To>" and find Woody Allen! (Notice, too, that my hidden identifier "To>" is in a tiny 8 point font so that it is nearly unnoticeable on the screen.)



Example 3: Skipping over YOUR fax number



If you have a header with YOUR fax number in it, you will want MergeFax to skip over your fax number and find the recipient’s fax number. You could simply make your fax number identifier anything different—like “Fax” or “(Fax)” or “Fax #”, etc. Or, if you want to use the same identifier for both your fax number and the recipient’s fax number, you can simply use a hidden identifier (like "Fax>"). Example:



ABC Widget Co
.


1225 Wilshire Blvd., Los Angeles, CA  93346

Phone: (213) 555-2444 Fax : (213) 555-2445



To: So-and-so.

Fax:  Fax> 555-555-5555



Dear So-and-so,



I love your widgets! Great work! Kudos!



Or, another way is to simply add a hidden space between "Fax" and the ":" in your letterhead. MergeFax will then skip over your fax number and find the recipient's fax number because it is looking for "Fax:" not "Fax(space):". On the screen, your fax number identifier will look like this: "Fax :". But that hidden space won't print, so on the fax, it will look like this: "Fax:".



So you see, with MergeFax 2.0, you have complete flexibility in designing your faxes to look exactly the way you want, while at the same time allowing MergeFax to find the recipient's name and fax number accurately.





Date and Time Scheduling



MergeFax allows you to send your group fax immediately or schedule them for a later date and time.



When  you choose "Now" (the default), MergeFax queues up all the faxes in WinFax PRO's event list. After the last fax is queued up and ready to go, WinFax begins sending them off.



When you choose "Scheduled", you can set the faxes for any future date and time. This is especially useful for taking advantage of the cheaper phone rates late at night.



When you schedule, remember that WinFax PRO only accepts date and time in the following formats: Date: MM/DD/YY. Time: HH:MM:SS. This is not hard to remember, as MergeFax displays the correct formats for you in the date and time fields. Notice, too, that MergeFax always defaults to today's date at 11:00pm that night. This is because the lowest phone rates occur in most places between 11:00pm - 8:00am.





Checking to make sure data is merging correctly



There are two ways to check and confirm that your data is merging correctly.



The first is before you run MergeFax. With the "view merged data" button on, you can click the "next record" button to jump from record to record and see how each record is merging with your mail-merge document. You'll know immediately if there are any changes you need to make to your data source before running MergeFax. (Or, you could also merge to a temporary document and browse it).



The second way is after you run MergeFax. With all the faxes scheduled and queued up in the WinFax event list, you can view and peruse the graphical fax pages to make sure they were merged properly. What you see at this point is exactly what will be sent, so you can be confident in the knowledge that everything merged perfectly.





Dialing Prefixes



MergeFax handles the following dialing prefixes automatically:



Outside line access codes



If you need to dial a prefix to get an outside line (for example "9"), MergeFax will automatically add this prefix before each fax number. You can also include commas for necessary delays (each comma = 2 second delay).



Note: MergeFax will ALWAYS add the default dialing prefix to EVERY fax number. If you don't use a default dialing prefix, leave this option blank in the MergeFax setup.



Local area code



MergeFax automatically recognizes your local area code and avoids dialing it. If you travel, move, or your local area code changes for any other reason, simply enter your new area code in the MergeFax installation program, and MergeFax will take care of the rest.



Note: The following dialing prefixes (Local area code, Long distance access code, Local long-distance access codes, and 800 prefix access code) may not work in some countries because of non-standard number lengths. MergeFax looks for 7 digit numbers (for eample 238-5798) and 10 digit numbers (for example 805-238-5798) to determine when local and long distance access codes need to be added. MergeFax only tests numbers that are 7 or 10 digits long.



If you dial many 7 and 10 digit numbers that do not fall into the North American standard (i.e. 3 digit area code followed by 7 digit number), you can leave the local area code blank in your MergeFax setup, and this will make MergeFax avoid testing ALL numbers—including 7 and 10 digit numbers.



Long distance access code



MergeFax will add a long distance dialing prefix to numbers outside of your local area code (usually a "1"). Note: The telephone companies are now in the process of eliminating these long distance access codes. When this change occurs in your area, simply re-run the MergeFax installation program and remove the long distance prefix.



Local long-distance access codes



MergeFax will add a dialing prefix to numbers WITHIN your local area code that require a long distance access code (usually "1"). Sometimes referred to as "toll calls," MergeFax automatically handles all of these local long distance numbers. Note: The telephone companies are in the process of eliminating these codes, also.



800 prefix access code



MergeFax will also automatically add the dialing prefix required for 800 numbers (usually "1").



Not supported: International access and local country codes



Note: International access codes and local country codes are not supported by MergeFax at this time. However, these codes can be handled by using either of the following two methods:



1) Simply include these codes in each fax number in your database. This is probably the simplest method, unless you already have a very large database. In that case, you can 2) Create a query that filters out all international numbers and then send them as a batch. For example, to dial the prefix "011" before every phone number, simply add it to your main mail-merge document before the fax number field like this:



		Fax: 011<<Fax Number>>



Tip: Just as hidden text works nicely for hidden identifiers, the same principle can be applied to numbers, or even text, that you need to pass to WinFax PRO, but that you don't want to show up on the fax. For example:



 		Fax: 011805-238-5798



You won't see the international code "011" on the fax, but MergeFax will find it, enter it in the fax number field, and pass it over to WinFax PRO for dialing. (Note: You can even include comma delays if needed.)





Suggestions



Read chapter 29 ("Mail Merge: Step by Step") in Word 6.0 User's Guide



If you already know how to mail merge, there is nothing more for you to learn to run MergeFax because MergeFax simply takes advantage of Word for Windows 6.0's awesome mail-merge features.



If you don't know how to mail merge, you'll need to learn how to set up a mail merge 
"
main
"
 document and attach a data source to it, etc. All this information is explained clearly in chapter 29 of the Word for Windows 6.0 User's Guide. Don't be intimidated. Word for Windows 6.0 has the simplest mail merge setup we've ever seen. You'll be up and rolling in no time.



Loading WinFax PRO



The most efficient way to use WinFax PRO and MergeFax is to have WinFax PRO already loaded, because this way, when you run MergeFax, it will pop right up. But even if WinFax PRO is not already loaded, it's no big deal. It only adds one more keystroke.



When you run MergeFax without WinFax PRO already loaded, the following message appears: “The remote data (control) is not accessible. Do you want to start the application FAXMNG?” FAXMNG is the main WinFax PRO program (it stands for “Fax Manager”). This message is Delrina's way of saying, "Do you want to load WinFax PRO?" So simply hit "Yes"—it will quickly load WinFax PRO—and MergeFax will take it from there.



Note: If you get an error when answering "yes" to "Do you want to start the application FAXMNG?", it usually means that the directory in which you installed WinFax PRO (usually C:\WINFAX) is not in your path statement in your autoexec.bat file. It should already be there, as WinFax PRO adds it during its installation.



WinFax PRO's Preview/Annotate feature



Note: We've found that MergeFax does not work with WinFax PRO's "Preview/Annotate" feature turned on. We have encountered strange behavior—sometimes even General Protection Faults—by running MergeFax with Preview/Annotate turned on. For some reason WinFax PRO cannot handle it. So remember to turn off "Preview/Annotate" before running MergeFax.



Intel CAS software users



Another incompatibility appears to exist between WinFax PRO and Intel CAS software. If you delete pending faxes from the WinFax Event List, the .DCX files that the Intel CAS software creates somehow do not get deleted. So you must go to the directory in which these .DCX files are stored and delete them manually. If you forget to do this, and you have scheduled these faxes to go at a certain time, the CAS software will start sending them out (even though they were deleted from the WinFax Event list).



Assigning MergeFax to a toolbar button



If you’re a toolbar person, assign MergeFax to a toolbar button. The only reason we didn’t automatically install it on your toolbar is because monitors that run 640x480 don’t have any more room to add toolbar buttons.



Upgrade from WinFax Lite to WinFax PRO 3.0, 4.0 (or WinFax PRO for Networks)



MergeFax does not work with Delrina's WinFax Lite because WinFax Lite does not support DDE like WinFax PRO 3.0, 4.0 (and WinFax PRO for Networks) does. Therefore, with WinFax Lite, MergeFax has nothing to "pass" the information to. If Delrina ever upgrades WinFax Lite to include DDE support, then MergeFax should work with it also. But until they do, only WinFax PRO 3.0, 4.0, and Network users can take advantage of MergeFax's dynamic data exchange.



Print out this MergeFax 2.0 User's Guide



We've put everything we could think of into this MergeFax 2.0 User's Guide. All of the most common questions and answers, problems and solutions, tips and tricks, etc. You might find this manual easier to read and refer to in printed form. Or, speaking of tips, here's another one: Whenever you need to refer back to something you've read in this manual, the quickest way is to use Word's edit-find command (Alt-E-F) to search for information regarding your question.





Registration



MergeFax 2.0 is shareware. Unregistered evaluation copies can be distributed freely. However, licensed copies can be used only by registered users who have purchased a permanent license.



You are encouraged to use this program for 5 sessions prior to obtaining a permanent license. You may share the files MERGEFAX.DOC, MERGEFAX.DOT, and MERGEFAX.BMP with anyone you choose as long as you do not change them. You may not share the registration key, which is supplied to licensed users only. If you choose to continue using the program and register, that registration key may be used only by the licensee specified in the original order for the license. Licenses are not transferable and may not be modified.



A single License permits you to use one copy of the MergeFax software on any single computer, provided the MergeFax software is in use on only one computer at any time. If you have multiple Licenses for MergeFax, then at any time you may have as many copies of MergeFax in use as you have Licenses.



INDIVIDUAL USE:

	SINGLE LICENSE for the use of MergeFax 2.0: $55



MULTIPLE USE:

	SITE LICENSE for the use of MergeFax 2.0:

2 to 9 computers�$42 each��10 to 24 computers�$32 each��25 to 49 computers�$26 each��50 to 99 computers�$19 each��100 to 199 computers�$14 each��200 to 500 computers�$12 each��

To register MergeFax 2.0, send a check or money order (payable to: Jay Bonzi) for your total number of Licenses to:



				BONZI SoftWare

				396 17th Street

				Paso Robles, CA  93446



Or you can register quickly by Fax or E-mail, with a charge card (Visa, MasterCard, or Discover). Simply include the name as it appears on the card, the card number, and expiration date. Send to either:



				Fax: (805) 238-5798

				CompuServe: 72053,2227



When you register, we will send you a personal registration number that will end the trial period and turn your evaluation copy into a licensed version. So even if you register by mail, you may want to include your fax number or e-mail address to more quickly receive your registration number.



You will also be entered into our database of licensed users, and thus immediately notified of future versions and updates.





FAstFax 4.0



Also, let us know if our other product FAstFax 4.0 sounds like something you might be interested in. FAstFax 4.0 is a powerful add-on program for Microsoft Word for Windows 6.0 and Delrina WinFax PRO 3.0, 4.0 (and WinFax PRO for Networks) that will save you and your employees hours of time.



Here’s how:



FAstFax scans your document, finds the recipient’s name and fax number, and (using DDE) automatically passes it over to WinFax PRO—so you no longer have to keep TWO separate phonebooks. If you’re tired of typing a person’s name and fax number TWICE—once on the document and again in the WinFax Phonebook—you will love FAstFax.



FAstFax gives you a thumbnail page preview of your document—so you’ll always fax the correct pages and be able to check the final look and layout of your fax before sending it off.



FAstFax allows you to easily fax an entire document or just the current page—which is great for those quick 1 page faxes.



FAstFax automatically sets the fax driver and resets the printer driver for you—so you don’t have to think about driver settings again. And no more print jobs accidentally sent to the fax modem!



FAstFax allows you to "Fax & Print" with one keystroke. For example, it sets your fax driver, faxes your document, then re-sets your printer driver, and prints your document—all automatically, all with one keystroke.



FAstFax also handles all of the following dialing prefixes automatically: Outside line access codes (for example "9"), Local area codes, Long distance access codes, Local long-distance access codes, and 800 prefix access codes.



Other features include: Cover Pages, File Attachments, Date and Time Scheduling, WinFax Phonebook Access, Resolution Choice, One Button Phonebook Entries, and more!



FAstFax does all this in 2 keystrokes!



The greatest benefit of FAstFax 4.0 is this: once you've entered a person's contact information into your database ONE TIME, you will never have to type it again. You can now keep all of your names and fax numbers in a PIM, Contact Manager, or even the Word 6.0 database—and once entered, you will never have to re-type a person's name and fax number again, either in the WinFax phonebook, or on the fax itself. (Even PIMs and Contact Manager software that integrate with the WinFax Phonebook cannot give you this because you'll still find yourself having to type the person's name and fax number on every fax.)





If you have any questions...



If you have any questions at all, feel free to fax me at 805-238-5798 any time, day or night. (Note: That's my home computer. And I work from 9:30am - 5:30pm Pacific time, so I’ll be able to fax you back that evening, or early the next morning. No matter what, I promise I’ll get back to you within 24 hrs.)



Or you can E-mail me on CompuServe at 72053,2227. I check my E-mailbox frequently, and if you're having problems, I'll get right back to you!





* * * * * * * * * * End of MergeFax User’s Guide * * * * * * * * * *



�



* * * * * License Agreement * * * * *



You are encouraged to use this program for 5 sessions prior to obtaining a permanent license. You may share the files MERGEFAX.DOC, MERGEFAX.DOT, and MERGEFAX.BMP with anyone you choose as long as you do not change them. You may not share the registration key, which is supplied to licensed users only. If you choose to continue using the program and register, that registration key may be used only by the licensee specified in the original order for the license. Licenses are not transferable and may not be modified. A single License permits you to use one copy of the MergeFax software on any single computer, provided the MergeFax software is in use on only one computer at any time. If you have multiple Licenses for MergeFax, then at any time you may have as many copies of MergeFax in use as you have Licenses.



It is your responsibility to determine if the program will work reliably on your equipment and for your particular business environment. BONZI SOFTWARE DISCLAIMS ALL WARRANTIES RELATING TO THIS SOFTWARE, WHETHER EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO ANY IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, AND ALL SUCH WARRANTIES ARE EXPRESSLY AND SPECIFICALLY DISCLAIMED. NEITHER BONZI SOFTWARE NOR ANYONE ELSE WHO HAS BEEN INVOLVED IN THE CREATION, PRODUCTION, OR DELIVERY OF THIS SOFTWARE SHALL BE LIABLE FOR ANY INDIRECT, CONSEQUENTIAL, OR INCIDENTAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE SUCH SOFTWARE EVEN IF BONZI SOFTWARE HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES OR CLAIMS. IN NO EVENT SHALL BONZI SOFTWARE'S LIABILITY FOR ANY DAMAGES EVER EXCEED THE PRICE PAID FOR THE LICENSE TO USE THE SOFTWARE, REGARDLESS OF THE FORM OF CLAIM. THE PERSON USING THE SOFTWARE BEARS ALL RISKS AS TO THE QUALITY AND PERFORMANCE OF THE SOFTWARE. Some states do not allow the exclusion of the limit of liability for consequential or incidental damages, so the above limitation may not apply to you.



This agreement shall be governed by the laws of the State of California and shall inure to the benefit of BONZI SoftWare and any successors, administrators, heirs and assigns. Any action or proceeding brought by either party against the other arising out of or related to this agreement shall be brought only in a STATE or FEDERAL COURT of competent jurisdiction located in San Luis Obispo County, California. The parties hereby consent to in personam jurisdiction of said courts.





* * * * * Acknowlegements - Trademarks * * * * *



WORD FOR WINDOWS and Microsoft are registered trademarks of Microsoft Corporation.



WINFAX PRO and Delrina are trademarks of Delrina Technology Inc.



MERGEFAX and FASTFAX are trademarks of BONZI SoftWare.
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